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1. OUTLINE

1.1 Foreword 
This instruction manual describes installation and operation for the parameter loader of the paperless 
recorder.  Read it carefully before use. 
 

1.2 Parameter loader for paperless recorder 
The parameter loader (hereinafter referred to as Loader) for the paperless recorder allows you to view 
(upload), edit, and set (download) parameters for the paperless recorder by connecting dedicated cable 
(option) of the Loader to the paperless recorder. 
 

1.3 Contents of package 
The following items are packaged with the product. 

• CD-ROM for installation: 1 
• Instruction manual which is installed to above CD-ROM 
 

1.4 Recommended operating environment 
• Microsoft Windows 98, 2000 or XP. 
• Hard disk with a free capacity of 30MB or more 
• RAM with 64MB or more 
• RS-232C serial port 
• Communication cable dedicated to parameter loader only (Option: PHZP0201) 

Note: 1) Operation by the self-made AT compatible machine and the remodeling machine is not 
secured. 

  Trouble might be caused in operation in a part of AT compatible machine or OS. 
 2) Operation by Windows 95/Me/NT is not secured. 

 

1.5 Installing the parameter loader for paperless recorder 
1) If other application software programs are open, terminate all of them. 
2) If the programming loader has been already installed, open “Add/Remove Programs” on 

Control Panel and delete the parameter loader. 
3) Set CD-ROM in the personal computer drive. 
4) Execute “E_top.pdf” saved at “English” folder in the CD-ROM. 
5) Follow the prompts displayed on the screen. 
6) A message is displayed, prompting you to verify that “Parameter loader setup is complete”.  

Now, the Parameter Loader installation is completed. 
 

1.6 Uninstalling the parameter loader software for paperless  
recorder 
Follow Windows operation. 
In case of installation of new loader software, you should delete current loader software which 
you use before installation of new loader software. 



 

1.7 Cautions 
When operating the Loader, be careful of the following items: 

• Before starting the paperless recorder, be sure to assure that the Loader setting is reflected to the 
paperless recorder. 

• For the communication setting for the paperless recorder (“Main Unit Set” → “System Setting”), 
the MODBUS communication function should be set to ON.  After the MODBUS 
communication function has been switched from OFF to ON, turn OFF the power once, and 
then turn it ON. 

• The Loader cannot use more than 1 window at the same time. 
If more than 1 window is open, leave only a single window open and close all of other windows 
(this can be checked on the Window menu). 

• The Loader is used for the paperless recorder only. 
• Initial values on each Loader screen may be different from those of the paperless recorder main 

unit. 
• Whenever you want to write the setting data on parameter loader into paperless recorder, please 

return the display of PHL to Display Mode such as Real Time Trend Screen. Don’t display  
Parameter Setting Screen, or this loader software may miss to write into the PHL. 

• At this loader, some parameters which do not exist on PHL may be displayed. But the parameter  
which doesn’t exist in the PHL isn’t written. 

• During PHL is recording or totalizing, it is impossible to write into PHL from this 
parameter loader. 
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2. BASIC OPERATION
 
2.1 Start 

Click “Programs” ⇒ “ PHL Parameter Loader” ⇒ “ PHL Parameter Loader” from the Start menu. 

 

It is displayed such as following screen. 
Note: Whenever, this screen is for 18th inputs.  It doesn’t depend on the input points. 

 

Table of setting channel display 



 

2.2 Table of setting channel display 
 
 
 

(6) File menu 

 

(7) Copy the setting value
(1) Communication setting

 
 
 

(1) Communication setting 
This function can change communication port of PC which communicates with paperless 
recorder.  At starting of this loader, COM1 is selected as communication port.  Set the port 
number that you want to use at first.  
At the executing screen, click [Com(R)] — [Port(P)] and select using port.  Normally, COM1 
is selected. 

 (5) Time setting 
to PHL 

  (4) Resister setting 
value 

 
 (3) Download setting 

value to PHL 

 

(2) Upload setting value 
from PHL 
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(2) Upload setting value from PHL 
It is available to upload all the setting such as channel setting, math channel setting, main 
setting, display setting and so on from PHL. 

(3) Download setting value to PHL 
It is available to download all the setting such as channel setting, math channel setting, main 
setting, display setting and so on to PHL. 
Note: 1) Download prohibit during recording or totalizing. 
 2) Be careful that if you don’t register set value, your setting isn’t registered, so when 

you turn off and on the PHL, setting value returns before you change. 
(4) Resister setting value 

It is available to register setting value to Flash ROM. 
(5) Time setting to PHL 

It is available to change time setting of PHL.  Press [Time setting] button, and screen as shown 
below appears.  Set the time that you want to change.  And then press [Change] button. 
Note: 1) This setting prohibit during recording or totalizing. 
 2) This setting is not necessary to register set value. 

 

 

Screen of time setting 
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(6) File menu 
This menu, you can use functions as shown below. 

 
 

a) Open 
Open the setting value file of PHL. 

b) Save 
Save into the setting value file of PHL, which name is *****. PHL. 
Note: ***** is free. 

c) Text output 
Output setting value as text data.. 
Please refer to attached “Appendix. 1: Example of setting parameters to be printed out.” 

d) Exit 
Exit this menu. 

Note: 1) If you change setting value of PHL, press [Set value register] before exit this software, 
or your setting isn’t registered, so when you turn off and on the PHL, setting value 
returns before you change. 

 2) If you want to use setting value on another day, it is recommended to save the setting 
value file of PHL before exit this software. 

(7) Copy the setting value 
Copy the setting value such as channel setting, main setting, display setting and so on. 
Click in line of original data and press [Copy].  Click in line that you want to copy., and then 
press [Paste]. 
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2.3 Setting channels 
Set the parameter regarding to input, calculation, alarm, display and record of each channel. 
On “Table of setting channel display”, double-click the channel you want to change. 
 

 
 

And then channel setting display appears. 

 
* It is available to set till 18ch whichever PHL is 9 or 18 input points. 
* There are some screen to be able to display up to 7 characters as channel tag in spite of setting is 

available up to 8 characters.  So don’t set 8 characters as channel tag. 
* When you set out of the range, message as shown below appears. 
 

 

Message in recording range 
 

* Press [Apply] after changing channel setting, or your setting isn’t registered, so when you turn off 
and on the PHL, setting value returns before you change. 
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* The input type becomes same kind in every two channels set. 
(1) The type setting of channel 2, 4, 6, 8, 11, 13, 15 and 17 is available only the same input category 

of previous channel.  Input type is shown as follows: 
Input category Input type 

Thermocouple, 50mV K-Type TC, E-Type TC, J-Type TC, T-Type TC, R-Type TC, S-Type 
TC, B-Type TC, N-Type TC, W-Type TC, L-Type TC, U-Type TC, 
PN-Type TC, 50mV 

Resistance bulb Pt100Ω, JPt100Ω, Ni100Ω, Pt50Ω, Cu50Ω 
500mV 500mV 
5V 1 to 5Vdc, 0 to 5Vdc 

 
The type setting of channel 9 and 18, there are no limit. 
For example, when channel 1 is set to 1 to 5Vdc, channel 2 is available to be set only 1 to 5Vdc, 
0 to 5Vdc or skip as shown below. 

 
 
Example: Setting input type of each channel 
 Input type Input type Explanation 
Channel 1 K-Type TC 
Channel 2 T-Type TC 

Thermocouple, 50mV It is available to set any type of TC or 
50mV. 

Channel 3 1 to 5V 
Channel 4 0 to 5V 

5V  

Channel 5 Pt100 
Channel 6 JPt100 

Resistance bulb It is available to set Pt100Ω or JPt100Ω. 

Channel 7 500mV 
Channel 8 500mV 

  

Channel 9 J-Type TC Thermocouple, 50mV It is available to set any input type to 
channel 9. 

Channel 10 K-Type TC 
Channel 11 50mV 

Thermocouple, 50mV It is available to set any type of TC or 
50mV. 

Channel 12 Skip 
Channel 13 1 to 5V 

5V 

Channel 14 Pt100 
Channel 15 Skip 

Resistance bulb 

Channel 16 Skip 
Channel 17 500mV 

500mV 

It is available to set skip under any input 
type. 

Channel 18 50mV Thermocouple, 50mV It is available to set any input type to 
channel 18. 
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(2) When you press [Apply] after changing input type setting of channel 1, 3, 5, 7, 10, 12, 14 and 
16, sometimes the screen as shown below appears. 

 

At this screen, if you press [OK] button, the input type of next channel is initialized to the same 
input type of current displayed channel.  In case of 50mV, the next channel becomes K-type 
TC. 
In case of resistance bulb, the next becomes Pt100Ω. 
 
* When you set input unit, set ON the “Scaling” at first.  And then press “SELECT” key.  

In case of Thermocouple or Resistance bulb input, it is available to select either Celsius or 
Fahrenheit.  And the others unit are not displayed. 

 
 

 The Unit Select screen appears.  On the screen that is displayed, click a unit and press the 
“Apply” button.  Note that the unit cannot be selected without pressing the “Apply” button. 

 
Example: At voltage input and scaling ON 
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2.3.1 Copying the channel set 
This screen allows you to copy one or more set values from one channel to another. 
Move the cursor to CH on the Table of Setting Channel display, and click it (channel selection). 
Click “Edit” ⇒ “Copy”. 
 
 

 
Move the cursor to CH where you want to paste channel settings and click it (Channel selection).  
Click “Edit” ⇒ “Paste”. 

 

 

 
 
Next, the following message appears, prompting you to select the option. 
Click “OK” when you want to copy the channel setting. 
If the input type is different between current type and new one, PHL works such as below. 
 
1) Copy to ch1 to ch8 or ch10 to ch17: 

The input type becomes same kind in every two channels, ch1 and ch2, ch3 and ch4, ch5 and 
ch6, ch7 and ch8, ch10 and ch11, ch12 and ch13, ch14 and ch15, ch16 and ch17, set.  If new 
input type is thermocouple, another channel’s type becomes K type thermocouple.  And if new 
one is Resistance bulb, another’s becomes Pt100ohm type. 

 
2) Copy to ch9 or ch18:  

No influence to the other input types. 

 

Click “Copy”. Select channel. 

Select “Paste”. Select “CH”. 



 
 

2.4 Setting math channels 
Set the parameter regarding to formula, calculation, alarm, display and record of each math channel. 
On “Table of setting math channel display”, double click the channel you want to change. 
 

 
 

And then math channel setting display appears. 

 
* It is available to set till 18ch whichever PHL is 19 to 30 input points. 
* There are some screen to be able to display up to 7 characters as channel tag in spite of setting is 

available up to 8 characters.  So don’t set 8 characters as channel tag. 
* When you set out of the range, message as shown below appears. 
 

 

Message in recording range 
 

* Press [Apply] after changing channel setting, or your setting isn’t registered, so when you turn off 
and on the PHL, setting value returns before you change. 
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2.4.1 Formula setting  

Please click the [Set] button in the column of formula of Math channel setting to set the formula. 
 

 
 
The Formula setting screen appears.  
 
* Please select the operational expression and the value respectively, push the [OK] button, and fix 

it. 
 
<List of functions that can be used for Formula setting> 

Grammar Operation Explanation 

None No operation Argument is used with no operation performed. 
ABS(A) Absolute value Finds the absolute value of input A. 
POW(A,B) Power Finds the value of input A to “input B”th power. 
SQR(A) Square root Finds the square root of the value of input A. 
LOG(A) Common logarithm Finds the common logarithm of the value of input A. 
LN(A) Natural logarithm Finds the natural logarithm of the value of input A. 
EXP(A) EXP Finds the exponentiation of the value of input A with base “e.” 
RH(A,B) Humidity Finds the relative humidity with input A assumed to represent dry-bulb 

temperature and input B wet-bulb temperature. 
MAX(A,B) Maximum  

(between channels) 
Compares input A and B and finds the larger value. 

MIN(A,B) Minimum  
(between channels) 

Compares input A and B and finds the smaller value. 

H-P(A) Maximum (time) Finds the maximum value of input A within a certain period of time. 
L-P(A) Minimum (time) Finds the minimum value of input A within a certain period of time. 
AVG(A) Average Finds the average value of input A within a certain period of time. 
SUM(A) Summation Finds the sum of input A within a certain period of time. 

 
 
<List of arguments (input) value that can be used for Formula setting> 

Argument Explanation Example 
Channel Input channel C01 
Totalize Totalize channel T01 
DI Digital input D01 
Communication Communication input M01 
Constant Constant K01 
Temporary data Result of previous operation B01 
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2.4.2 Copying the math channel set 
This screen allows you to copy one or more set values from one channel to another. 
Move the cursor to CH on the Table of Setting Channel display, and click it (channel selection). 
Click “Edit” ⇒ “Copy”. 
 
 

 
Move the cursor to CH where you want to paste channel settings and click it (Channel selection).  
Click “Edit” ⇒ “Paste”. 

 

 

 
 
Next, the following message appears, prompting you to select the option. 
Click “OK” when you want to copy the channel setting. 
If the input type is different between current type and new one, PHL works such as below. 
 

Click “Copy”. Select channel. 

Select “Paste”. Select “CH”. 
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2.5 Setting the main unit 
This screen allows you to set the recorder main unit. 
Move the cursor to MAIN UNIT on the Table of Setting Channel display, and click it. 

 
 

 

Click. 

 
The Main unit Set screen appears. 
* If values are entered over the specified range, the following message appears. 
 

 

Alarm Hysteresis message  
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2.5.1 DI function setting (option) 
The DI function allows you to accept the ON/OFF input from external devices connected to external 
terminals of DI1 to DI0. 

 

 
 

Note: DI1-DI5 cannot be used because DI (external control unit) option cannot be mounted when the 
input point is 18 points. 
Without the communication function, DI6-DI10 cannot be used. 
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2.6 Display setting 
At this screen, you can see or set regarding to screen setting such as structure of screen, trend display 
screen and so on.  Click “Display setting” tab of [Structure of setting channel display]. 

 

 
 

Setting screen appears and you can see status about screen setting. 

 
2.6.1 Display setting 

At this screen, you can set regarding to screen setting such as structure of screen, trend display screen 
and so on.  Double click the group No. at “Display group” column on Display setting screen,  
* Edit the displayed group on “Selected group No.”. 
* Screen name can set to PHL up to 16 characters. 
* If scale display is ON, trend screen is divided in accordance with the scale, not the setting of 

“Display divided”. 

 
2.6.2 Setting channels 

Set the structure of screen. 
No.1 at this screen equals to data 1 of “display setting” of PHL, No.2 equals to data 2.  Following is 
the same as above until No.10. 
* In case of PHL is 9 inputs type, this screen displays until No.10. 
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2.6.3 Setting message 
The screen allows you to set messages to be displayed when an event occurs. 
Move the cursor to No. of the Message box on the Main Unit Set screen and double-click it. 

 
 

The Message Setting screen appears. 

 
* Up to 32 characters is available for the message.  The characters exceeding 32 cannot be 

displayed on the recorder main unit. 
 
* After the input of message set data, be sure to press the “Apply” button, or the message cannot be 

registered. 
 
* Message timing is allocated as follows: 

 

 
 
 

Channel No. 
Set alarm No. 

 

 

 
 
 

DI No. 
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2.6.4 Unit coding 

Units can be made in alphanumerical characters.  This unit can be registered in the input unit when 
scaling is set to ON on the Channel Setting screen. 
Move the cursor to No. of the Unit box on the Main Unit Set screen and double-click it. 

 

The Unit Setting screen appears. 

 
* A message (unit) consisting of up to 7 characters is available for the recording main unit. 
 
* After the input of unit set data, be sure to press the “Apply” button, or the unit cannot be 

registered. 
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APPENDIX.1 EXAMPLE OF SETTING PARAMETERS 
TO BE PRINTED OUT 

 
2004/04/14 13:07:30 

 

PILC   : PHL11B11-E10RY 

Ser.No.: Z4A0001T 

Ver.   : V07L 

 

*****Channel setting***** 

Measuring range Engineering unit 
 Input type Color Tag No.1 Tag No.2 Input unit 

Scaling  

ON/OFF Start End Start End 

Square  

rooter 

CH1 Pt100 Red TAG 01 TAG 31 °C OFF 0.0 500.0 0.0 500.0 OFF 

CH2 Pt50 Blue TAG 02 TAG 32 °C OFF 0.0 500.0 0.0 500.0 OFF 

CH3 50mV Violet TAG 03 TAG 33 MV OFF 0.00 50.00 0.00 50.00 OFF 

CH4 K-Type TC Green TAG 04 TAG 34 °C OFF 0.0 500.0 0.0 500.0 OFF 

CH5 500mV Deep green TAG 05 TAG 35 MV OFF 0.0 500.0 0.0 500.0 OFF 

CH6 500mV Purple TAG 06 TAG 36 MV ON 0.0 500.0 0.0 500.0 OFF 

CH7 1-5V Sky blue TAG 07 TAG 37 V ON 1.000 5.000 0.000 5.000 OFF 

CH8 0-5V Yellow TAG 08 TAG 38 V OFF 0.000 5.000 0.000 5.000 OFF 

CH9 T-Type TC Indigo TAG 09 TAG 39 °C OFF 0.0 500.0 0.0 500.0 OFF 

CH10 Ni100 Dark red TAG 10 TAG 40 °C OFF 0.0 500.0 0.0 500.0 OFF 

CH11 Cu50 Red TAG 11 TAG 41 °C OFF 0.0 500.0 0.0 500.0 OFF 

CH12 50mV Blue TAG 12 TAG 42 MV ON 0.00 50.00 0.00 50.00 OFF 

CH13 K-Type TC Violet TAG 13 TAG 43 °C OFF 0.0 500.0 0.0 500.0 OFF 

CH14 500mV Green TAG 14 TAG 44 MV OFF 0.0 500.0 0.0 500.0 OFF 

CH15 500mV Deep green TAG 15 TAG 45 MV ON 0.0 500.0 0.0 500.0 OFF 

CH16 1-5V Purple TAG 16 TAG 46 V OFF 1.000 5.000 0.000 5.000 OFF 

CH17 0-5V Sky blue TAG 17 TAG 47 V ON 0.000 5.000 0.000 5.000 OFF 

CH18 PN-Type TC Yellow TAG 18 TAG 48 °C OFF 0.0 500.0 0.0 500.0 OFF 

 
Display range  

 
Input 

Filter 
PV shift PV gain 

Subtract 

channel 

Fvalue 

calc. 

Recording 

Mode 
Recording type 

Start End 

CH1  1   0.0 100.00 None      OFF With record Min-Max value   0.0  500.0 

CH2  1   0.0 100.00 channel1 OFF With record Point value     0.0  500.0 

CH3  1  0.00 100.00 None      OFF With record Average value  0.00  50.00 

CH4  1   0.0 100.00 None      ON  With record Min-Max value  0.00 120.00 

CH5  1   0.0 100.00 None      OFF With record Point value     0.0  500.0 

CH6  1   0.0 100.00 None      OFF With record Average value   0.0  500.0 

CH7  1 0.000 100.00 channel16 OFF With record Min-Max value 1.000  5.000 

CH8  1 0.000 100.00 None     OFF With record Point value   0.000  5.000 

CH9  1   0.0 100.00 channel4 ON  With record Average value  0.00  30.00 

CH10 1   0.0 100.00 None     OFF With record Min-Max value   0.0  150.0 

CH11 1   0.0 100.00 None     ON  With record Point value    0.00  15.00 

CH12 1  0.00 100.00 channel3 OFF With record Average value  0.00  50.00 

CH13 1   0.0 100.00 None     OFF With record Min-Max value   0.0 1200.0 

CH14 1   0.0 100.00 channel5 OFF With record Point value     0.0  500.0 

CH15 1   0.0 100.00 Channel6 OFF With record Average value   0.0  500.0 

CH16 1 0.000 100.00 None     OFF With record Min-Max value 1.000  5.000 

CH17 1 0.000 100.00 channel8 OFF With record Point value   0.000  5.000 

CH18 1   0.0 100.00 channel9 ON  With record Average value  0.00 130.00 

 

*****Totalize setting***** 

 Totalize 

Tag 

Totalize 

calc. 

Totalize  

Type 

Digital input Totalize 

Base time 

Reset 

operation 

Totalize 

Unit 

Totalize 

Cut value 

Totalize 

Scale value 

CH1  STAG 01 Totalizer Periodic DI1  /s   ON  Unit 01   0.0   1 

CH2  STAG 02 Totalizer Daily    DI1  /s   ON  Unit 02   0.0   1 

CH3  STAG 03 Totalizer Weekly   DI1  /s   ON  Unit 03  0.00   1 

CH4  STAG 04 Totalizer Monthly  DI1  /s   ON  Unit 04  0.00   1 

CH5  STAG 05 Totalizer Annual   DI1  /s   ON  Unit 05   0.0   1 

CH6  STAG 06 Totalizer Daily(Time set) DI1  /s   ON  Unit 06   0.0   1 

CH7  STAG 07 Totalizer External DI1  /s   OFF Unit 07 0.000   1 

CH8  STAG 08 Counter Periodic Ch30 Alarm4 /day ON  Unit 08 0.000   1 

CH9  STAG 09 Counter Daily    Ch30 Alarm3 /min ON  Unit 09  0.00   1 

CH10 STAG 10 Counter Weekly   Ch30 Alarm2 /min OFF Unit 10   0.0   1 

CH11 STAG 11 Counter Monthly  Ch30 Alarm1 /day ON  Unit 11  0.00   1 

CH12 STAG 12 Counter Annual   Ch1 Alarm1  /day ON  Unit 12  0.00   1 

CH13 STAG 13 Counter Daily(Time set) Ch1 Alarm2  /s   OFF    0.0   5 

CH14 STAG 14 Counter External Ch1 Alarm3  /min ON     0.0 100 

CH15 STAG 15 Timer   Periodic Ch10 Alarm1 /s   ON    10.0   1 

CH16 STAG 16 Timer   Daily    DI1  /h   ON   0.500   1 

CH17 STAG 17 Timer   Weekly   DI1  /day ON   0.005   1 

CH18 STAG 18 Timer   Monthly  DI1  /day ON    1.05   1 

 



 

 

*****Alarm setting***** 

 Alarm No.1 Alarm No.2 Alarm No.3 Alarm No.4 

 
Alarm 

type 

Alarm set 

value 

DO relay 

No. 

Alarm 

type 

Alarm set 

value 

DO relay 

No. 

Alarm 

type 

Alarm set 

value 

DO relay 

No. 

Alarm 

type 

Alarm set 

value 

DO relay 

No. 

CH1  H    10.0    1 OFF   0.0 None OFF   0.0 None OFF   0.0 None   

CH2  OFF   0.0 None H    20.0    5 OFF   0.0 None OFF   0.0 None   

CH3  OFF  0.00 None OFF  0.00 None H    0.00    7 OFF  0.00 None   

CH4  OFF  0.00 None OFF  0.00 None OFF  0.00 None H   40.00   10   

CH5  OFF   0.0 None OFF   0.0 None OFF   0.0 None OFF   0.0 None   

CH6  OFF   0.0 None OFF   0.0 None OFF   0.0 None OFF   0.0 None   

CH7  OFF 1.000 None OFF 1.000 None OFF 1.000 None OFF 1.000 None   

CH8  OFF 0.000 None OFF 0.000 None OFF 0.000 None OFF 0.000 None   

CH9  OFF  0.00 None OFF  0.00 None OFF  0.00 None OFF  0.00 None   

CH10 L   -10.0   11 OFF   0.0 None OFF   0.0 None OFF   0.0 None   

CH11 OFF  0.00 None L   20.00   15 OFF  0.00 None OFF  0.00 None   

CH12 OFF  0.00 None OFF  0.00 None L   30.00   20 OFF  0.00 None   

CH13 OFF   0.0 None OFF   0.0 None OFF   0.0 None L   -50.0   25   

CH14 OFF   0.0 None OFF   0.0 None OFF   0.0 None OFF   0.0 None   

CH15 OFF   0.0 None OFF   0.0 None OFF   0.0 None OFF   0.0 None   

CH16 OFF 1.000 None OFF 1.000 None OFF 1.000 None OFF 1.000 None   

CH17 OFF 0.000 None OFF 0.000 None OFF 0.000 None OFF 0.000 None   

CH18 OFF  0.00 None OFF  0.00 None OFF  0.00 None OFF  0.00 None   

 

*****Math channel setting***** 

 Formula    Formula   

CH19 B01   = ABS(K01)+POW(K02,K04)/SQR(K03) CH25    B01 =  

     B02   = LOG(K05)*EXP(K03)-LN(K06)         B02 =  

     B03   = B01-MAX(K07,K09)*MIN(K08,K10)         B03 =  

     Result = B01/B02+B03         Result = EXP(M09)    

CH20 B01   =  CH26    B01 =             

     B02   =          B02 =             

     B03   =          B03 =             

     Result = ABS(C17)       Result = RH(T26,D06) 

CH21 B01   =  CH27    B01 =             

     B02   =          B02 =             

     B03   =          B03 =             

     Result = POW(T14,M04)        Result = MAX(T09,K16) 

CH22 B01   =  CH28    B01 =             

     B02   =          B02 =             

     B03   =          B03 =             

     Result = SQR(M08)       Result = H-P(M03)    

CH23 B01   =  CH29    B01 =             

     B02   =          B02 =             

     B03   =          B03 =             

     Result = LOG(K17)       Result = AVG(K10)    

CH24 B01   =  CH30    B01 =             

     B02   =          B02 =             

     B03   =          B03 =             

     Result = LN(K20)       Result = SUM(C01,C07) 
 

Measuring range Engineering unit 
 Color Tag No.1 Tag No.2 Input unit 

Start End Start End 
Square rooter 

CH19 Indigo   TAG 19 TAG 49 °C 0.000 5.000 0.000 5.000 OFF 

CH20 Dark red TAG 20 TAG 50 °C 0.000 5.000 0.000 5.000 OFF 

CH21 Red      TAG 21 TAG 51 °C   0.0 500.0   0.0 500.0 OFF 

CH22 Blue     TAG 22 TAG 52 °C  0.00 50.00  0.00 50.00 OFF 

CH23 Violet   TAG 23 TAG 53 °C     0  5000     0  5000 OFF 

CH24 Green    TAG 24 TAG 54 °C   0.0 500.0   0.0 500.0 OFF 

CH25 Deep green TAG 25 TAG 55 °C   0.0 500.0   0.0 500.0 OFF 

CH26 Purple   TAG 26 TAG 56 °C   0.0 500.0   0.0 500.0 OFF 

CH27 Sky blue TAG 27 TAG 57 °C   0.0 500.0   0.0 500.0 OFF 

CH28 Yellow   TAG 28 TAG 58 °C   0.0 500.0   0.0 500.0 OFF 

CH29 Indigo   TAG 29 TAG 59 °C     0  5000     0  5000 OFF 

CH30 Dark red TAG 30 TAG 60 °C   0.0 500.0   0.0 500.0 OFF 

 
Display range 

 
Input 

Filter 
PV shift PV gain 

Subtract 

channel 

Fvalue 

calc. 

Recording 

Mode 

Recording  

type Start End 

CH19 0 0.000 100.00 None OFF With record Min-Max value 0.000 12.000 

CH20 0 0.000 100.00 None OFF With record Point value   0.000 12.000 

CH21 0   0.0 100.00 None OFF With record Average value   0.0 1200.0 

CH22 0  0.00 100.00 None OFF With record Min-Max value  0.00 120.00 

CH23 0     0 100.00 None OFF With record Point value       0  12000 

CH24 0   0.0 100.00 None OFF With record Average value   0.0 1200.0 

CH25 0   0.0 100.00 None OFF With record Min-Max value   0.0 1200.0 

CH26 0   0.0 100.00 None OFF With record Point value     0.0 1200.0 

CH27 0   0.0 100.00 None OFF With record Average value   0.0 1200.0 

CH28 0   0.0 100.00 None OFF With record Min-Max value   0.0 1200.0 

CH29 0     0 100.00 None OFF With record Point value       0  12000 

CH30 0   0.0 100.00 None OFF With record Average value   0.0 1200.0 
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*****Totalize setting***** 

 Totalize 

Tag 

Totalize 

calc. 

Totalize 

Type 

Digital 

input 

Totalize 

Base time 

Reset 

operation 

Totalize 

Unit 

Totalize 

Cut value 

Totalize 

Scale value 

CH19 STAG 19 Totalizer Periodic Ch3 Alarm2 /day OFF  0.000 1 

CH20 STAG 20 OFF Periodic DI1 /h   ON   0.000 1 

CH21 STAG 21 OFF Periodic DI1 /h   ON     0.0 1 

CH22 STAG 22 OFF Periodic Ch6 Alarm3 /min OFF   0.00 1 

CH23 STAG 23 OFF Periodic DI1 /h   ON       0 1 

CH24 STAG 24 OFF Periodic DI1 /h   ON     0.0 1 

CH25 STAG 25 Totalizer Monthly  Ch10 Alarm2 /s   OFF    0.0 1 

CH26 STAG 26 OFF Periodic DI1 /h   ON     0.0 1 

CH27 STAG 27 OFF Periodic DI1 /h   ON     0.0 1 

CH28 STAG 28 OFF Periodic DI1 /h   ON     0.0 1 

CH29 STAG 29 OFF Periodic DI1 /h   ON       0 1 

CH30 STAG 30 OFF Periodic DI1 /h   ON     0.0 1 

 
*****Alarm setting***** 

 Alarm No.1 Alarm No.2 Alarm No.3 Alarm No.4 

 Alarm Alarm set DO relay Alarm Alarm set DO relay Alarm Alarm set DO relay Alarm Alarm set DO relay  

 Type value No. type value No. type value No. type value No. 

CH19 OFF 0.000 None OFF 0.000 None OFF 0.000 None OFF 0.000 None   

CH20 OFF 0.000 None OFF 0.000 None OFF 0.000 None OFF 0.000 None   

CH21 OFF   0.0 None OFF   0.0 None OFF   0.0 None OFF   0.0 None   

CH22 OFF  0.00 None OFF  0.00 None OFF  0.00 None OFF  0.00 None   

CH23 OFF     0 None OFF     0 None OFF     0 None OFF     0 None   

CH24 OFF   0.0 None OFF   0.0 None OFF   0.0 None OFF   0.0 None   

CH25 OFF   0.0 None OFF   0.0 None OFF   0.0 None OFF   0.0 None   

CH26 OFF   0.0 None OFF   0.0 None OFF   0.0 None OFF   0.0 None   

CH27 OFF   0.0 None OFF   0.0 None OFF   0.0 None OFF   0.0 None   

CH28 OFF   0.0 None OFF   0.0 None OFF   0.0 None OFF   0.0 None   

CH29 OFF     0 None OFF     0 None OFF     0 None OFF     0 None   

CH30 OFF   0.0 None OFF   0.0 None OFF   0.0 None OFF   0.0 None   

 

*****Basic setting***** 

Display refreshment cycle 1 min        Alarm hysteresis    0.50  (%)    Alarm latch ON        

LCD lights-out time     10  min        Memory full alarm DO relay No.      5        Battery alarm  DO relay No.     25   

MODBUS Station NO.    255      MODBUS baud rate    9600  bps   MODBUS parity Even      

Recording data format Binary    

Configuration password    1357     CF manager password    2468     REC key password    9753   

 

*****Fvalue calculation setting***** 

Target temperature   100.0  °C  Z value    10.0  °C  Decimal point position      2   
Fvalue reset temperature     5.0  °C 
 

*****Totalize setting***** 

Totalize base time 12:30      Totalize recording cycle 10 min    

Weekly base day Wednesday  Monthly base day     15   

Totalize start time 10:30     stop time 20:30     

Extrnal input Ch30 Alarm4      

 

*****Math timer setting***** 

H-P/L-P operation       5  min   AVG operation       2  min   SUM operation      10  min 

 
*****Display setting***** 

 Content of screen composition 

 No.1 No.2 No.3 No.4 No.5 No.6 No.7 No.8 No.9 No.10 

Display group1 channel1 channel2 channel3 channel4 channel5 channel6 channel7 channel8 channel9 channel10 

Display group2 channel11 channel12 channel13 channel14 channel15 channel16 channel17 channel18 channel19 channel20 

Display group3 channel21 channel22 channel23 channel24 channel25 channel26 channel27 channel28 channel29 channel30 

Display group4 channel1 None None channel10 None None channel19 None None channel30 

 

 Display name 
Trend 

direction 

Display 

division No. 

Scale 

display 

Bar graph/ 

Analog meter 

Color bar 

display selection 

Display group1 Display Group 1 Vertical  1 ON Bar graph Channel No. 

Display group2 Display Group 2 Horizontal 20 ON Bar graph Tag No. 

Display group3 Display Group 3 Vertical  5 ON Analog meter Unit  

Display group4 Display Group 4 Horizontal 15 ON Analog meter Tag No. 

 

*****Message setting***** 

 Message Timing1 
DI NO./ 

Alarm Channel 
Alarm NO. 

No.1 Message DI 4 ON DI ON DI4  

No.2 Message DI 10 OFF DI OFF DI10  

No.3 Message Alarm 1 No.1 ON Alarm ON CH.1 Alarm No.1 

No.4 Message Alarm 5 No.4 OFF Alarm OFF CH.5 Alarm No.4 

No.5 Message Alarm 10 No.2 ON Alarm ON CH.10 Alarm No.2 

No.6 Message Alarm 18 No.3 OFF Alarm OFF CH.18 Alarm No.3 

No.7 Message DI 2 ON DI ON DI2  

No.8 Message DI 7 OFF DI OFF DI7  

No.9 Message Alarm 21 No.2 ON Alarm ON CH.21 Alarm No.2 

No.10 Message Alarm 30 No.4 OFF Alarm OFF CH.30 Alarm No.4 
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*****Original Unit definition***** 

 No.1 No.2 No.3 No.4 No.5 No.6 

Unit Unit 01 Unit 02 Unit 03 Unit 04 Unit 05 Unit 06 

 No.7 No.8 No.9 No.10 No.11 No.12 

Unit Unit 07 Unit 08 Unit 09 Unit 10 Unit 11 Unit 12 

 

*****DI functionting***** 

DI-1 Rec start/stop DI-6 Rec start/stop 

DI-2 Totalize start/stop DI-7 Totalize start/stop 

DI-3 Totalize reset DI-8 Totalize reset 

DI-4 Fvalue calc. reset DI-9 Fvalue calc. reset 

DI-5 LCD ON DI-10 LCD ON 

 

*****Constant setting***** 

Constant1  1.00 Constant11 -32767 

Constant2  20.0 Constant12 32767 

Constant3  3.000 Constant13 -3276.7 

Constant4  0.04 Constant14 3276.7 

Constant5  0.0005 Constant15 -327.67 

Constant6  66.6 Constant16 327.67 

Constant7  700.0 Constant17 -32.767 

Constant8  80.00 Constant18 32.767 

Constant9  0.009 Constant19 -3.2767 

Constant10 10 Constant20 3.2767 
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Head office
6-17, Sanbancho, Chiyoda-ku, Tokyo 102-0075,  Japan
http://www.fesys.co.jp

Sales Div.
International Sales Dept.
No.1, Fuji-machi, Hino-city, Tokyo 191-8502,  Japan
Phone: 81-42-585-6201, 6202   Fax: 81-42-585-6187
http://www.fic-net.co.jp
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